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Εισαγωγικές σημειώσεις για τη χρήση του επεξεργαστή κειμένου Microsoft Word, με έμφα-
ση στα στοιχεία που χρειάζονται για τη δημιουργία μιας εργασίας-αναφοράς σε μαθήματα 

της Σχολής Χημικών Μηχανικών ΕΜΠ. 
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Πρόλογος 
Η Σχολή Χημικών Μηχανικών ΕΜΠ εφαρμόζει ένα πρόγραμμα σπουδών πλούσιο σε εργα-

στηριακές ασκήσεις. Συνήθως κάθε άσκηση ολοκληρώνεται με τη συγγραφή μιας αναφο-

ράς, ενώ αρκετές είναι και οι βιβλιογραφικές εργασίες που εκπονούνται κατά τη διάρκεια 

των σπουδών. 

Δυστυχώς έχει διαπιστωθεί ότι η πλειοψηφία των φοιτητών δεν γνωρίζει βασικά στοιχεία 

χρήσης ενός πακέτου επεξεργασίας κειμένων, καταβάλλοντας έτσι άσκοπα μεγάλη προ-

σπάθεια και παράγοντας αποτέλεσμα που επιδέχεται αρκετών βελτιώσεων ως προς στοι-

χειώδη τεχνικά σημεία. Αυτό είναι λογική συνέπεια του ότι θεωρείται (εσφαλμένα) δεδομέ-

νο πως οι εισαγόμενοι στη σχολή φέρουν σχετική γνώση. Δυστυχώς, η εκμάθηση βασικών 

εφαρμογών γραφείου και προγραμματισμού έχουν «στριμωχτεί» στο μάθημα του 1ου εξα-

μήνου «Προγραμματισμός και Χρήση Η/Υ – Βασικά Εργαλεία Λογισμικού» και ο χρόνος δεν 

επαρκεί ούτε καν για την παρουσίαση «της κορυφής της μύτης του παγόβουνου». Το παρόν 

κείμενο προέκυψε από μια σχετική παρουσίαση στην «Ομάδα Παρουσιάσεων στη Χρήση 

Η/Υ», η οποία δημιουργήθηκε το ακαδ. έτος 2011-12 από φοιτητές για την κάλυψη τέτοιων 

κενών εφαρμοσμένης-τεχνικής γνώσης. 

 Σε αυτό το φυλλάδιο θα γίνει μια απόπειρα κάλυψης κατά το δυνατόν πληρέστερα όσων 

στοιχείων μπορεί να χρειαστεί ένας φοιτητής της Σχολής για να χειριστεί το πακέτο Mi-

crosoft Word, αφήνοντας στην άκρη θέματα γενικότερης οργάνωσης μιας εργασίας. Η πα-

ρουσίαση βασίζεται στην αγγλική έκδοση του Microsoft Word 2010. Από την έκδοση 2007 

του MS Office έχει αναθεωρηθεί αρκετά το γραφικό περιβάλλον, ωστόσο οι βασικές δυνα-

τότητες υπάρχουν και σε προηγούμενες εκδόσεις, απλώς προσπελάζονται με άλλο τρόπο. 

Ήδη είναι διαθέσιμη η έκδοση 2013, ωστόσο το περιβάλλον παραμένει αντίστοιχο. 

Αντίστοιχο φυλλάδιο ετοιμάζεται και για το ελεύθερο λογισμικό LibreOffice Writer, ενώ ελ-

πίζουμε σύντομα να δημιουργηθεί και (άλλος) ένας συνοπτικός οδηγός «γρήγορης εκκίνη-

σης» για το σύστημα στοιχειοθεσίας LaTeX, το οποίο διέπεται από διαφορετική φιλοσοφία 

και προτείνεται συχνά για τη συγγραφή επιστημονικού κειμένου που πρέπει να ακολουθεί 

συγκεκριμένα πρότυπα ή να έχει ειδικό περιεχόμενο όπως μαθηματικές ή χημικές εξισώ-

σεις. Αξίζει να σημειωθεί πως το κείμενο αυτού του φυλλαδίου οπωσδήποτε επιδέχεται δι-

ορθώσεις και σημαντικές βελτιώσεις και ο καθένας παρακινείται να συνεισφέρει στην προ-

σπάθεια, προτείνοντας αλλαγές σε αυτό. 

 

Το περιεχόμενο αυτού του φυλλαδίου υπάγεται σε Άδεια Χρήσης Creative Commons Attrib-

ution-ShareAlike 3.0 Greece. 

Το πηγαίο αρχείο καθώς και αντίγραφο αυτού του φυλλαδίου μπορεί να βρεθεί στο forum 

Χημικών Μηχανικών ΕΜΠ: http://www.chemeng-ntua.gr/viewtopic.php?f=95&t=1699 

Τα Microsoft Office Word, Microsoft Office Excel, Mirosoft Windows, Apple MacOS X, 

Mathcad, Mathematica, Maple είναι καταχωρημένα εμπορικά σήματα εταιρειών. 
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1 Τι είναι το Microsoft Word; 

1.1 Επεξεργαστής κειμένου 
Το Microsoft Word είναι ένας επεξεργαστής κειμένου. Αυτό που καθιστά διαφορετικό έναν 

επεξεργαστή κειμένου από έναν απλό κειμενογράφο όπως π.χ. τον Microsoft Notepad ή τον 

Geany ή τον GNU Emacs ή τον Vim (ή...) είναι η δυνατότητα μορφοποίησης του κειμένου 

που παράγεται (χρώμα, μέγεθος, σελιδοποίηση, χειρισμός παραγράφων κτλ). Το στοιχείο 

αυτό καθιστά έναν επεξεργαστή κειμένου ιδανικό για την παραγωγή κειμένου π.χ. μιας ερ-

γασίας αλλά εντελώς ακατάλληλο για τη συγγραφή κώδικα μιας γλώσσας προγραμματι-

σμού, καθώς ανάμεσα στο κείμενο προστίθενται «κρυφές» εντολές μορφοποίησης. 

1.2 What You See Is What You Get 
Το Microsoft Word ανήκει στην κατηγορία «WYSIWYG» (What You See Is What You Get). 

Αυτό σημαίνει πως μπορούμε κατευθείαν στην οθόνη να βλέπουμε τι (περίπου) θα τυπωθεί 

ή αλλιώς, ποιο θα είναι το τελικό αποτέλεσμα. Για παράδειγμα, ένα βαρυπατημένο κομμάτι 

κειμένου, θα εμφανιστεί «βαρυπατημένο» και στην επεξεργασία και στο τελικό αποτέλε-

σμα. Αντιθέτως, σε μια markup language όπως η HTML, κατά την επεξεργασία θα είχαμε 

«<b>βαρυπατημένο</b>» και στο τελικό αποτέλεσμα «βαρυπατημένο». Αξίζει να ση-

μειωθεί ότι και στο Word, το κείμενο αποθηκεύεται σε μια αντίστοιχη μορφή, αλλά στον 

χρήστη εμφανίζεται κατευθείαν το μορφοποιημένο κείμενο. Στην ίδια κατηγορία με το MS 

Word ανήκει το ελεύθερο LibreOffice Writer και πολλά άλλα αντίστοιχα προγράμματα. 

Το σύστημα αυτό προσφέρει μερικά σημαντικά πλεονεκτήματα και μερικά σημαντικά μει-

ονεκτήματα. Το προφανές του πλεονέκτημα είναι η ευκολία που προσφέρει στη μορφο-

ποίηση και το ότι κατά την επεξεργασία βλέπει κανείς μορφοποιημένο κείμενο αντί για ένα 

μείγμα κειμένου και εντολών. Ένα βασικό του μειονέκτημα είναι ότι η απόκριση του υπολο-

γιστή γίνεται ιδιαίτερα αργή όταν χτιστεί ένα μεγάλο αρχείο με πολλές μορφοποιήσεις και 

αντικείμενα όπως εικόνες, εξισώσεις κτλ. Συνεπώς, για τη χρήση ενός σύγχρονου WYSIWYG 

επεξεργαστή κειμένου με σκοπό την παραγωγή εκτενών κειμένων, επιθυμείται ένας σύγ-

χρονος και σχετικά ισχυρός Η/Υ (ένα netbook θα δυσκολευτεί). Επίσης, επειδή το κείμενο 

αποθηκεύεται μαζί με τις μορφοποιήσεις, απαιτείται η έκδοση του πακέτου που χρησιμο-

ποιούμε για να διορθώσουμε π.χ. μια εργασία μας να είναι συμβατή με τον τύπο αρχείου 

της εργασίας μας, άρα υπάρχει θέμα συμβατότητας ανάμεσα σε διαφορετικά προγράμματα 

και διαφορετικές εκδόσεις του ίδιου προγράμματος. Τέλος, επειδή η επεξεργασία γίνεται 

σε πραγματικό χρόνο, συχνά δεν είναι δυνατό να επιτευχθεί το άριστο τυπογραφικά αποτέ-

λεσμα (θέση αντικειμένων, διαχείριση παραγράφων κ.α.). 

Στον αντίποδα αυτής της φιλοσοφίας ανήκει το δημοφιλές και ελεύθερο «σύστημα στοιχει-

οθεσίας» LaTeX. Σε αυτό, το κείμενο κατά την επεξεργασία του είναι ένα μείγμα κανονικού 

κειμένου και εντολών μορφοποίησης και αποθηκεύεται ως απλό αρχείο κειμένου, επεξερ-

γάσιμο από οποιονδήποτε απλό κειμενογράφο και κατά συνέπεια διαχρονικά υποστηρίξι-

μο. Για τη δημιουργία του τελικού αρχείου γίνεται μια διαδικασία «μεταγλώττισης» (compi-

lation), παρόμοια με αυτήν με την οποία ένας κώδικας π.χ. Fortran μετατρέπεται σε εκτελέ-

σιμο αρχείο, με τη διαφορά ότι εδώ παράγεται ένα αρχείο pdf. Προτιμάται συχνά για τη 

δημιουργία κειμένου προς δημοσίευση, καθώς συνήθως παράγει άριστο τυπογραφικά α-

ποτέλεσμα και επιτρέπει εύκολη συγγραφή του κειμένου πάνω σε συμφωνημένα πρότυπα, 
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αδιαφορώντας για τη διαχείριση της μορφοποίησης, σελιδοποίησης, τακτοποίησης αντικεί-

μενων, αρίθμησης κτλ, τα οποία γίνονται αυτόματα. Προτιμάται επίσης για τις ιδιαίτερα 

καλές δυνατότητές του στη δημιουργία μαθηματικών εξισώσεων και τις ατέλειωτες συλλο-

γές από ειδικά σύμβολα και εργαλεία (π.χ. για χημικές εξισώσεις, παρτιτούρες κ.α.). Φυσι-

κά, υπάρχουν εξειδικευμένοι κειμενογράφοι με συντομεύσεις για την ευκολότερη εισαγω-

γή εντολών LaTeX αλλά και WYSIWG κειμενογράφοι για LaTeX με τα δικά τους πλεονεκτή-

ματα και μειονεκτήματα. 

1.3 Εμπορικό ιδιόκτητο λογισμικό - λογισμικό κλειστού κώδικα 
Κάθε λογισμικό που διατίθεται σε κάποιον (οφείλει να) συνοδεύεται από μια άδεια χρήσης, 

η οποία περιγράφει κάποιους όρους χρήσης. Το Microsoft Office είναι ιδιόκτητο (proprie-

tary) λογισμικό κλειστού κώδικα (closed-source). Αυτό σημαίνει ότι η άδεια χρήσης του επι-

τρέπει μονάχα τη χρήση υπό κάποιους όρους και απαγορεύει κάθε τι άλλο, όπως το να 

τροποποιήσετε ή αναδιανείμετε το πρόγραμμα, ενώ δεν μπορείτε να δείτε πώς έχει δημι-

ουργηθεί. Επίσης, είναι ένα εμπορικό πρόγραμμα, κάτι που σημαίνει ότι πρέπει να πληρώ-

σετε ώστε να είστε νόμιμος χρήστης του. Μάλιστα, θα πρέπει να πληρώσετε ώστε να ανα-

βαθμίσετε σε μια νεότερη έκδοση του προγράμματος η οποία να υποστηρίζει τις νέες λει-

τουργίες και, κυρίως, τους νέους τύπους αρχείων. Τέλος, το ιδιόκτητο λογισμικό συνήθως 

αναπτύσσεται μονάχα για ένα λειτουργικό σύστημα (Windows ή MacOS X), δεσμεύοντάς 

σας σε αυτό. 

Παράλληλα, τα πρότυπα (τύποι αρχείων) που χρησιμοποιεί κυρίως είναι κλειστά. Αυτό ση-

μαίνει ότι δεν μπορεί ο καθένας να φτιάξει εύκολα ένα πρόγραμμα που να υποστηρίζει 

πλήρως αυτά τα πρότυπα. Έτσι, εάν θέλετε να αλλάξετε το πρόγραμμα που χρησιμοποιείτε, 

δεν είναι σίγουρο ότι τα αρχεία που έχετε δημιουργήσει ως τώρα θα συνεχίσουν να υπο-

στηρίζονται σωστά για άνοιγμα ή επεξεργασία και θα πρέπει να διατηρείτε εγκατεστημένο 

και το Microsoft Office εάν δεν σας ικανοποιεί η διαχείριση που κάνει στα σχετικά αρχεία 

το νέο σας πρόγραμμα. 

Στον αντίποδα, υπάρχει το ελεύθερο λογισμικό – λογισμικό ανοιχτού κώδικα καθώς και τα 

ανοιχτά πρότυπα. Τα προγράμματα που ακολουθούν αυτό το μοντέλο διανέμονται δωρεάν 

στον χρήστη και επιπλέον, ο χρήστης έχει την ελευθερία να αναδιανείμει το πρόγραμμα, να 

δει τον κώδικα, να τον τροποποιήσει και να διανείμει τροποποιημένες εκδόσεις. Οι ελεύθε-

ρες άδειες χρήσης συνήθως προβλέπουν την αναφορά των αρχικών δημιουργών σε κάθε 

τροποποίηση, καθώς και τη διανομή των παραγώγων πάλι υπό ελεύθερη άδεια, χτίζοντας 

έτσι μια συλλογή ελεύθερου λογισμικού. Τα ανοιχτά πρότυπα υποστηρίζονται από πληθώ-

ρα διαφορετικών προγραμμάτων, τα οποία πολλές φορές υπάρχουν για κάθε δημοφιλές 

λειτουργικό σύστημα (πχ Windows, MacOS X, Linux). Συγκεκριμένα, το Open Document 

Format υποστηρίζεται και στο Microsoft Office, είτε εγγενώς είτε μέσω προσθέτων. Οι λόγοι 

που έχουν οδηγήσει στην ανάπτυξη αυτού του μοντέλου είναι κατά βάση φιλοσοφικοί και 

κυρίως για αυτούς προτιμάται συχνά από την ακαδημαϊκή κοινότητα. 
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2 Περιβάλλον χρήσης - σύνοψη λειτουργιών 
Ανοίγοντας το Word 2010 παρατηρούμε αμέσως το βασικό στοιχείο του User Interface του: 

την «κορδέλα» εργαλείων (ribbon) στο πάνω μέρος. Η κορδέλα αυτή συγκεντρώνει όλες τις 

βασικές λειτουργίες του προγράμματος, κατηγοριοποιώντας τες σε καρτέλες (tabs).  

Στην καρτέλα Home θα βρείτε τις λειτουργίες που θα χρησιμοποιείτε συχνότερα: τη μορ-

φοποίηση κειμένου (bold, italic, χρώμα), τη στοίχιση, τα bullets και τα «στυλ». Προσοχή 

όμως! Όποιος ανοίγει για πρώτη φορά το Word τείνει να χρησιμοποιεί πχ τη λειτουργία 

bold και να αυξάνει το μέγεθος της γραμματοσειράς για να φτιάξει τίτλο. Θα δούμε σύντο-

μα ότι αυτός δεν είναι ο «σωστός» τρόπος. Κυρίως λοιπόν θα χρησιμοποιείτε τα «στυλ» 

από εδώ.  

Στην καρτέλα Insert θα βρείτε επιλογές για εισαγωγή πίνακα, εικόνας, σχημάτων, εξισώ-

σεων και ειδικών συμβόλων. Από εδώ μπορείτε επίσης να δημιουργήσετε ένα εξώφυλλο, 

να εισάγετε μια κενή σελίδα ή ένα διαχωριστικό σελίδας (να αλλάξετε σελίδα), να βάλετε 

αριθμούς σελίδας, να βάλετε κεφαλίδες ή υποσέλιδα. Μπορείτε επίσης να βάλετε συνδέ-

σμους προς ιστοσελίδες ή προς σημεία εντός του εγγράφου. 

Στην καρτέλα Page Layout μπορείτε να ρυθμίσετε τα χαρακτηριστικά της σελίδας όπως 

το περιθώριο, τον προσανατολισμό (κατακόρυφο ή οριζόντιο), το μέγεθος, αν θα έχει στή-

λες, περίγραμμα, υδατογράφημα κτλ. Από εδώ επιλέγετε επίσης το «στιλιστικό θέμα» που 

θα χρησιμοποιείτε, δηλαδή π.χ. με ποιους συνδυασμούς χρωμάτων και γραμματοσειρών 

θα εμφανίζονται οι τίτλοι, το κείμενο και άλλα στοιχεία. Από εδώ μπορείτε επίσης να χωρί-

σετε ενότητες με διαφορετική αρίθμηση σελίδων. Επίσης, μπορείτε να ενεργοποιήσετε τις 

«υφενώσεις» για τον συλλαβισμό τον λέξεων και τον χωρισμό τους σε δυο σειρές όταν 

χρειάζεται, ώστε να διατηρηθούν ομοιόμορφα τα κενά μεταξύ των λέξεων σε όλες τις 

γραμμές. 

Στην καρτέλα References μπορείτε να διαχειριστείτε τις αναφορές, δηλαδή τις παραπο-

μπές στη βιβλιογραφία (Citations & Bibliography), σε σχήματα του κειμένου (Cross-

reference), σε υποσημειώσεις (Footnotes). Μπορείτε επίσης να φτιάξετε έναν πίνακα περι-

εχομένων, σχημάτων, πινάκων ή ένα ευρετήριο όρων.  

Η καρτέλα Mailings αφορά λειτουργίες σχετικές με αλληλογραφία (δεν θα ασχοληθού-

με). Η καρτέλα Review αφορά λειτουργίες αναθεώρησης του κειμένου, όπως διόρθωση 

ορθογραφικών λαθών, εισαγωγή σχολίων, παρακολούθηση αλλαγών κτλ. Τέλος, η καρτέλα 

View ρυθμίζει το πώς βλέπουμε το κείμενό μας (π.χ. μεγέθυνση). Χρήσιμο από εδώ θα ή-

ταν να ενεργοποιήσετε το “Navigation Pane” για την εύκολη μετάβαση από το ένα σημείο 

του εγγράφου στο άλλο. 

Πάνω αριστερά θα βρείτε το μενού File, από το οποίο έχετε πρόσβαση στις υπόλοιπες 

λειτουργίες, όπως αποθήκευση, εκτύπωση, εξαγωγή σε PDF, τα αρχεία βοήθειας (Help) και 

τις ρυθμίσεις του προγράμματος. 

Στη συνέχεια θα δούμε λίγο αναλυτικότερα μερικές συνήθεις λειτουργίες. 
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3 Γραμματοσειρές 
Μια γραμματοσειρά είναι πρακτικά ένα σύνολο από χαρακτήρες οι οποίοι μπορούν να εμ-

φανιστούν στην οθόνη του υπολογιστή μας, κατ’ αντιστοιχία με ένα σετ τυπογραφικών 

στοιχείων σε ένα κλασσικό τυπογραφείο. Στην πραγματικότητα, στον υπολογιστή μια γραμ-

ματοσειρά είναι ένα σύνολο-αρχείο από «γλυφές» (γραφικές αναπαραστάσεις μέσω εξισώ-

σεων) κωδικοποιημένων συμβόλων (φανταστείτε αριθμούς). Η εμβάθυνση στο θέμα ξε-

φεύγει από τα εισαγωγικά πλαίσια αυτού του οδηγού. Κρατήστε μονάχα ότι είναι επιθυμη-

τό να χρησιμοποιείται κάποια γραμματοσειρά με κωδικοποίηση Unicode, που να περιλαμ-

βάνει γλυφές για όλες τις γλώσσες που θα χρησιμοποιήσουμε στο κείμενό μας. Αν η γραμ-

ματοσειρά περιέχει και γλυφές ελληνικών χαρακτήρων, τότε δίπλα στο όνομά της εμφανί-

ζεται η λέξη «Ελλάδα» στο μενού γραμματοσειρών του Word. Σημειώστε πως, εάν επιλέ-

ξουμε μια γραμματοσειρά που δεν υποστηρίζει ελληνικούς χαρακτήρες, τότε για αυτούς θα 

χρησιμοποιηθεί κάποια άλλη, προεπιλεγμένη γραμματοσειρά και το αποτέλεσμα δεν θα 

είναι ομοιόμορφο. 

3.1 Είδη γραμματοσειρών 

3.1.1 Serif και Sans-serif 

Οι γλυφές κάθε γραμματοσειράς έχουν κάποια χαρακτηριστικά. Για παράδειγμα, υπάρχουν 

γραμματοσειρές με ακρέμονες (ή ακρεμόνες ή «πατούρες»), οι οποίες λέγονται διεθνώς 

serif και γραμματοσειρές χωρίς ακρέμονες (sans-serif). Για παράδειγμα, παρατηρήστε τις 

παρακάτω λέξεις: 

 

 

Αριστερά (Times New Roman), βλέπουμε πως τα άκρα των γραμμάτων δεν κόβονται από-

τομα, αλλά έχουν κάποιες «ουρίτσες». Αντιθέτως, δεξιά (Arial), κάθε γράμμα αποτελείται 

από σαφείς γραμμές που τελειώνουν απότομα. Συνηθίζεται οι serif γραμματοσειρές να 

χρησιμοποιούνται σε βιβλία, ως πιο «όμορφες» και οι sans-serif σε παρουσιάσεις και ιστο-

σελίδες ως πιο ευκρινείς σε χαμηλές αναλύσεις. Διαδεδομένη αλλά υπό συζήτηση είναι η 

άποψη ότι οι γραμματοσειρές με ακρέμονες είναι πιο «ξεκούραστες» για το μάτι, καθώς το 

ένα γράμμα οδηγεί στο επόμενο «αρμονικότερα». Έντονα serifs μπορεί να είναι ακατάλλη-

λα για π.χ. τεχνικά κείμενα, γι’ αυτό υπάρχουν πολλές διαφορετικές γραμματοσειρές.  

3.1.2 Ισοπαχείς και ανισοπαχείς 

Παρατηρήστε τις παρακάτω γραμματοσειρές: 

  

 

 

Επάνω (Calibri), κάθε γράμμα καταλαμβάνει διαφορετικό χώρο οριζοντίως. Αντιθέτως, κάτω 

(Courier New), κάθε γράμμα καταλαμβάνει τον ίδιο χώρο με τα άλλα. Έτσι, δυο λέξεις 

με το ίδιο πλήθος χαρακτήρων, η μια κάτω από την άλλη, θα πιάνουν τον ίδιο χώρο. Για το 

Ποδήλατο Ποδήλατο 

Βιβλίο 

Βιβλίο 
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λόγο αυτό οι ισοπαχείς (ή γραμματοσειρές γραφομηχανής) χρησιμοποιούνται για την πα-

ρουσίαση κώδικα, όπου χρησιμοποιείται στοίχιση με βάση την «κολώνα» από την οποία 

ξεκινάει κάθε «γραμμή» κώδικα. 

3.1.3 Καλλιγραφικές – χειρόγραφες – ειδικές γραμματοσειρές 

Υπάρχουν ακόμη γραμματοσειρές με ειδικά χαρακτηριστικά, ώστε π.χ. να θυμίζουν χειρό-

γραφο (καλλιγραφικό ή μη) κείμενο. Για παράδειγμα, δείτε τις γραμματοσειρές Monotype 

Corsiva, Comic Sans MS, Impact. Είναι γραμματοσειρές που θα πρέπει να αποφύγετε σε 

οποιοδήποτε σοβαρό κείμενο όπως μια εργασία. Επίσης, καλό θα ήταν να χρησιμοποιείτε 

συνεπώς μία γραμματοσειρά στο κείμενό σας (βλ. ομαδικές εργασίες). 

3.2 Μέγεθος γραμματοσειράς 
Κάθε γραμματοσειρά χαρακτηρίζεται από ένα μέγεθος, το οποίο συνήθως μετράται σε τυ-

πογραφικές στιγμές (points). Συνήθη μεγέθη αναφοράς είναι το ύψος του πεζού “x” ή το 

ύψος του κεφαλαίου “M” και άλλα. Σε βιβλία, για κανονικό κείμενο συνηθίζεται να χρησι-

μοποιούνται γραμματοσειρές μεγέθους 10 έως 12 τυπογραφικών στιγμών. Το παρόν κείμε-

νο έχει γραφτεί με γραμματοσειρά Calibri μεγέθους 11pt. 

3.3 Bold, Italics και Underline 
Θα έχετε παρατηρήσει ότι, σε ορισμένες περιστάσεις, κάποιες λέξεις μπορεί να εμφανίζο-

νται βαρυπατημένες (bold) ή με πλάγια γράμματα (italics) ή και τα δυο. Συνήθως τα γράμ-

ματα εμφανίζονται όρθια (roman). Επίσης, το κείμενο μπορεί να είναι και υπογραμμισμένο. 

Στην κλασική τυπογραφία, κάθε διαφορετικό μέγεθος ήταν μια διαφορετική γραμματοσει-

ρά που όλα μαζί αποτελούσαν την ίδια οικογένεια γραμματοσειρών (font family). Αντιστοί-

χως, κάθε ένα από τα π.χ. bold, italics ήταν μια διαφορετική οικογένεια γραμματοσειρών, 

στο ίδιο typeface. Π.χ., θα έπρεπε να υπάρχουν άλλα τυπογραφικά στοιχεία για την Arial 

(Normal) και άλλα για την Arial Bold και την Arial Italic κοκ.  

Στους Η/Υ, έχοντας την κανονική γραμματοσειρά σε ένα μέγεθος μπορούμε να παράξουμε 

τα υπόλοιπα μέσω κλίμακας, αφού έχουμε να κάνουμε με διανυσματικές αναπαραστάσεις. 

Αντιστοίχως μπορούμε να παράγουμε π.χ. bold και italics. Ορισμένες φορές ωστόσο παρέ-

χεται ξεχωριστή γραμματοσειρά για π.χ. bold η οποία αποδίδει καλύτερα τον χαρακτήρα 

της γραμματοσειράς. 

Περισσότερες τυπογραφικές λεπτομέρειες αξιοποιούνται στο LaTeX. 

4 Στοίχιση, παράγραφοι και υφενώσεις 
Από την καρτέλα Home μπορούμε να επιλέξουμε τη στοίχιση μιας παραγράφου. Οι επιλο-

γές μας είναι στοίχιση στα αριστερά, στα δεξιά, στο κέντρο ή «πλήρης στοίχιση» ώστε το 

κείμενο να καταλαμβάνει όλο το διαθέσιμο πλάτος. Για να επιτευχθεί αυτό, το Word απλώ-

νει ή συμπιέζει τις αποστάσεις μεταξύ των λέξεων ώστε να πιάσουν όλο το πλάτος. Αποτέ-

λεσμα είναι να προκύπτουν ανομοιόμορφα κενά σε διαφορετικές γραμμές. Παρατηρήστε 

όμως τα βιβλία σας ή αυτό το κείμενο. Οι λέξεις που βρίσκονται στο τέλος των παραγρά-

φων, ορισμένες φορές χωρίζονται με μια παύλα. Αυτό γίνεται αυτόματα ως εξής: 
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καρτέλα Page Layout > Hyphenation > Automatic 

Εάν θέλουμε να στοιχίσουμε την αρχή κάθε παραγράφου δεξιότερα, θα πρέπει κατ’ αρχάς 

να εμφανίσουμε τους «χάρακες» (rule) του Word, από το εικονίδιο που βρίσκεται πάνω 

από την κατακόρυφη γραμμή κύλισης (scroll bar). Εμφανίζεται ένα σύμβολο σε σχήμα κλε-

ψύδρας. Μετακινώντας το πάνω κομμάτι δεξιότερα ρυθμίζουμε την στοίχιση της αρχής της 

παραγράφου. Για να κάνουμε τη στοίχιση μόνιμη, θα πρέπει να επέμβουμε στο στυλ (βλ. 

παρακάτω).  

Σε μερικά τεχνικά κείμενα δεν εφαρμόζεται ο κλασσικός συμβολισμός αλλαγής παραγρά-

φου (εσοχή στην πρώτη γραμμή), αλλά όλες οι γραμμές ξεκινάνε από την ίδια οριζόντια 

θέση. Αυτό μπορεί να είναι αισθητικά προτιμότερο όταν στο κείμενο υπάρχουν και άλλα 

στοιχεία τα οποία στοιχίζονται δεξιότερα (π.χ. εξισώσεις). Παρατηρήστε τα βιβλία σας και 

υιοθετήστε το στυλ κάποιου βιβλίου που να σας φαίνεται ευανάγνωστο. 

Οι γραμμές σε μια παράγραφο απέχουν μεταξύ τους κάποια απόσταση η οποία καλείται 

«διάστιχο» (line spacing). Αντιστοίχως, κάθε παράγραφος διατηρεί μια απόσταση από την 

προηγούμενη και από την επόμενή της (paragraph spacing). Τα μεγέθη αυτά ρυθμίζονται 

από το κουμπί Line and Paragraph Spacing που υπάρχει στην κεντρική καρτέλα. 

Αν έχουμε δημιουργήσει μια μορφοποίηση σε κάποιο σημείο του κειμένου την οποία θέ-

λουμε να εφαρμόσουμε και σε άλλα σημεία του κειμένου, τότε μπορούμε να χρησιμοποιή-

σουμε το «πινέλο» από την κεντρική καρτέλα (Format Painter). Τοποθετούμε τον κέρ-

σορα μέσα σε μια λέξη από την οποία θέλουμε να αντιγράψουμε τη μορφοποίηση (γραμ-

ματοσειρά, χρώμα, bold-italic κτλ) και πατάμε το πινέλο. Στη συνέχεια, το περνάμε πάνω 

από τα σημεία του κειμένου τα οποία θέλουμε να μορφοποιήσουμε. 

Για να έχουμε καλύτερο έλεγχο στις αλλαγές γραμμών, παραγράφων κτλ, μπορούμε να εμ-

φανίσουμε τα σημάδια αλλαγής ως εξής: καρτέλα Home > Show/Hide ¶. 

5 Στυλ: Τίτλοι, κείμενο και εύκολες αλλαγές μορφοποίησης 
Σημαντικό χώρο στην κεντρική καρτέλα καταλαμβάνει το μενού Styles. Ξεχάστε το «για 

να φτιάξω έναν τίτλο μεγαλώνω τη γραμματοσειρά και κάνω bold/υπογραμμίζω»! Ξεχάστε 

το «δεν μου αρέσει αυτή η γραμματοσειρά, επιλέγω όλο το κείμενο και την αλλάζω»! Εκτός 

του ότι είναι κουραστικό να επαναλαμβάνεται κάθε φορά χειρονακτικά μια εργασία ρουτί-

νας, υπάρχει σημαντική πιθανότητα (έως βεβαιότητα) παρουσίασης ασυνεπειών, όπως για 

παράδειγμα, άλλα τμήματα του κειμένου να είναι γραμμένα σε γραμματοσειρά 11pt και 

άλλα σε 12pt. Ταυτόχρονα, η χρήση στυλ μας δίνει τη δυνατότητα να κάνουμε αυτόματα 

κάποιες εργασίες όπως η δημιουργία ενός πίνακα περιεχομένων ή η αλλαγή θέσης σε ενό-

τητες του κειμένου. 

5.1 Εισαγωγή ενός τίτλου ενότητας και μορφοποίηση με στυλ 
Για να εισάγουμε έναν τίτλο «επιπέδου 1», επιλέγουμε το στυλ Heading 1 και γράφουμε 

αυτό που θέλουμε να εμφανίζεται ως τίτλος. Πατώντας το enter για να αλλάξουμε γραμμή, 

επιστρέφουμε στο προεπιλεγμένο στυλ Normal. Αν θέλουμε να δημιουργήσουμε μια υπο-

ενότητα, θα πρέπει να επιλέξουμε το στυλ Heading 2 και δημιουργούμε μια «ενότητα 
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επιπέδου 2». Αν μέσα σε αυτήν θέλουμε να δημιουργήσουμε μια άλλη υποενότητα, πρέπει 

να επιλέξουμε το στυλ Heading 3 κοκ. Για παράδειγμα, σε αυτό το κείμενο, το «Γραμμα-

τοσειρές» είναι επιπέδου 1, το «Είδη γραμματοσειρών» είναι επιπέδου 2 και το «Serif και 

Sans-serif» είναι επιπέδου 3. Αντιστοίχως μπορούμε να δημιουργήσουμε έναν τίτλο και έ-

ναν «υπότιτλο» για το κείμενό μας με τα στυλ Title και Subtitle – Subtitle 

emphasis. 

Προαιρετικά, αντί για το κλασσικό italic ή το bold, μπορούμε να χρησιμοποιήσουμε τα στυλ 

Emphasis, Intense Emphasis και Strong. Μπορούμε έτσι να αλλάξουμε ευκολότε-

ρα το πώς εμφανίζεται το αντίστοιχο κείμενο. Για παράδειγμα, σε ορισμένα σημεία του κει-

μένου, εμφανίζεται κείμενο με πλάγια χρωματιστά γράμματα για να δοθούν με μια ματιά 

τα κεντρικά σημεία. Αυτό έχει γίνει με τροποποίηση του στυλ Emphasis. 

Για να αριθμήσουμε τις κεφαλίδες, τοποθετούμε τον κέρσορα σε μια κεφαλίδα τύπου 

Heading 1 και στη συνέχεια, από την καρτέλα Home επιλέγουμε Multilevel List. 

5.2 Τροποποίηση ή δημιουργία ενός νέου στυλ 
Μπορούμε να αλλάξουμε τα χαρακτηριστικά ενός στυλ και οι αλλαγές θα εφαρμοστούν σε 

όλο το κείμενο που έχει ήδη γραφτεί ή θα γραφτεί στη συνέχεια. Για παράδειγμα: 

Κάνοντας δεξί κλικ στο στυλ Emphasis, επιλέγουμε Modify. Μπορούμε να αλλάξουμε τη 

γραμματοσειρά και το μέγεθός της, το αν θα είναι έντονη, πλάγια ή υπογραμμισμένη, κα-

θώς και το χρώμα της. Μπορούμε επίσης να ορίσουμε από ποιο άλλο στυλ «κληρονομεί» 

τα χαρακτηριστικά του. Παρατηρούμε ότι το στυλ Emphasis βασίζεται στο στυλ Normal 

με τη διαφορά ότι χρησιμοποιείται πλάγια γραμματοσειρά. Θέλουμε να αλλάξουμε το χρώ-

μα: επιλέγουμε αυτό που θέλουμε από το σχετικό μενού και πατάμε ΟΚ. Οι αλλαγές μας 

έχουν εφαρμοστεί! 

Συνεπώς, αν θέλουμε απλώς να αλλάξουμε τη γραμματοσειρά στο κείμενό μας, τροποποι-

ούμε το στυλ Normal, αλλάζοντας τη γραμματοσειρά του! 

Έστω ότι θέλουμε να δημιουργήσουμε ένα νέο στυλ. Για παράδειγμα, ένα στυλ για παρου-

σίαση κώδικα. Θέλουμε να βασίζεται στο κανονικό στυλ αλλά να έχει ισοπαχή γραμματο-

σειρά. Γράφουμε κάτι σε στυλ Normal. Στη συνέχεια, το επιλέγουμε και αλλάζουμε τη 

γραμματοσειρά του. Η Courier New είναι π.χ. μια ισοπαχής γραμματοσειρά. Στη συνέχεια, 

κάνουμε δεξί κλικ σε αυτό που γράψαμε και επιλέγουμε  

Styles > Save Selection as a New Quick Style… 

Δίνουμε ένα επιθυμητό όνομα και πατάμε OK. Το στυλ που δημιουργήσαμε εμφανίζεται 

τώρα ως επιλογή ανάμεσα στα υπόλοιπα και μπορούμε να το τροποποιήσουμε όπως τα 

υπόλοιπα ή να το διαγράψουμε. 

Δίπλα στην παλέτα των «στυλ» υπάρχει το κουμπί Change Styles. Από εκεί μπορούμε 

να δοκιμάσουμε διάφορους έτοιμους συνδυασμούς χρωμάτων και γραμματοσειρών, οι 

οποίοι θα εφαρμοστούν σε όλα τα στυλ. 
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Ταυτόχρονα, στην καρτέλα Page Layout, μπορείτε να βρείτε τις ίδιες επιλογές αλλά και 

την αλλαγή ολόκληρου του αισθητικού Theme του εγγράφου σας. Θυμηθείτε να εφαρμό-

ζετε την κρίση σας για την επιλογή ενός «θέματος» και να το τροποποιείτε όπως πιστεύετε 

ότι θα διευκόλυνε την αναγνωσιμότητα και την αισθητική του κειμένου σας. Οι προτεινό-

μενοι συνδυασμοί δεν είναι απαραίτητα καλοί επειδή είναι έτοιμοι και σίγουρα δεν ταιριά-

ζουν σε κάθε είδος κειμένου! 

5.3 Δημιουργία πίνακα περιεχομένων 
Έχοντας καθορίσει που ξεκινάει κάθε ενότητα (με τα στυλ τύπου Heading), το Word μπορεί 

να δημιουργήσει αυτόματα έναν πίνακα περιεχομένων. Αυτό γίνεται τοποθετώντας τον 

κέρσορα στο σημείο που θέλουμε να δημιουργηθεί ο πίνακας και στη συνέχεια: 

καρτέλα References > Table of Contents > Automatic Table 

όπου «Automatic Table», ένα από τα διαθέσιμα αυτόματα στυλ πίνακα περιεχομένων. 

Ο πίνακας δεν ενημερώνεται σε πραγματικό χρόνο! Πριν την εκτύπωση του εγγράφου μας, 

θα πρέπει να ανανεώσουμε τον πίνακα περιεχομένων ώστε να προστεθούν οι νέες ενότητες 

ή να διορθωθούν οι αριθμοί σελίδας αν έχουν αλλάξει. 

κλικ στον πίνακα περιεχ.> Update Table… > Update entire table 

5.4 Μετακίνηση ενοτήτων 
Έστω ότι θέλουμε να αλλάξουμε θέση σε μια ολόκληρη ενότητα ή υποενότητα (θα μπορού-

σε να είναι π.χ. ένα ολόκληρο κεφάλαιο). Αντί να κάνουμε cut-paste, χρησιμοποιούμε το 

Navigation Pane: 

καρτέλα View > Navigation Pane 

Από εκεί, μπορούμε να πλοηγηθούμε γρήγορα σε όποια ενότητα θέλουμε. Μπορούμε επί-

σης, κάνοντας drag-n-drop στις ενότητες να τις μετακινήσουμε. 

Αντίστοιχες δυνατότητες παρέχονται και από την παρουσίαση του κειμένου υπό μορφή 

Outline (βλ. κάτω δεξιά). 

6 Αριθμοί σελίδων και κεφαλίδες 
Για να εμφανίσουμε τους αριθμούς σελίδας: 

καρτέλα Insert > Page Number > επιθυμητή θέση > επιθυμητό στυλ 

Από τα αντίστοιχα κουμπιά μπορούμε να εισάγουμε κεφαλίδα ή υποσέλιδο στο κείμενό 

μας, διαλέγοντας από έτοιμα στυλ. Χρήσιμο είναι στην κεφαλίδα να εμφανίζεται ο τίτλος 

του κειμένου και ο συγγραφέας, για την περίπτωση π.χ. που χαθεί κάποια σελίδα. 

Άλλος τρόπος πρόσβασης σε αυτές τις λειτουργίες είναι κάνοντας διπλό κλικ στην κορυφή ή 

στο κάτω μέρος της σελίδας. Εμφανίζονται τότε επιλογές όπως ο διαχωρισμός σελίδων άρ-

τιου και περιττού αριθμού και η απόκρυψη τους από την πρώτη σελίδα. 
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Έστω τώρα ότι θέλουμε να έχουμε διαφορετικές μεγάλες ενότητες (sections) στο κείμενό 

μας και ότι θέλουμε να έχουν διαφορετική αρίθμηση σελίδων. Π.χ. το παράρτημα να έχει 

αρίθμηση σελίδων με λατινικούς αριθμούς. Θα πρέπει καταρχάς να βάλουμε ένα διαχωρι-

στικό ενοτήτων: 

καρτέλα Page Layout > Breaks > Section Breaks > Next Page 

όπου Next Page ότι επιθυμούμε. Για να καθορίσουμε το στυλ αρίθμησης που θέλουμε: 

καρτέλα Insert > Page Number > Format Page Numbers… 

Εδώ αλλάζουμε το Number Format στο επιθυμητό και επιλέγουμε το Start at πλη-

κτρολογώντας τον πρώτο κατά σειρά αριθμό. 

Χρήσιμη παρατήρηση: αν θέλουμε να αλλάξουμε σελίδα, αντί να πατάμε πολλές φορές το 

enter, εισάγουμε ένα Page Break: 

καρτέλα Insert > Page Break 

7 Μαθηματικές παραστάσεις 
Το Word διαθέτει ειδικό εργαλείο για τη δημιουργία μαθηματικών παραστάσεων. Το εργα-

λείο αυτό έχει βελτιωθεί σημαντικά στις νεότερες εκδόσεις. Για την εισαγωγή μιας «εξίσω-

σης»: 

καρτέλα Insert > Equation 

Εμφανίζεται μια καρτέλα με εργαλεία για τη δημιουργία μαθηματικών παραστάσεων. 

Μπορούμε να χρησιμοποιήσουμε το ποντίκι για τη χρήση τους είτε κάποιες συντομεύσεις 

πληκτρολογίου (βλ. παράρτημα). Παράδειγμα: 

∫     
 

 

 
 

 
 

Διευκρινίζεται ότι το Word μπορεί μονάχα να εμφανίσει παραστάσεις. Δεν κάνει υπολογι-

σμούς. Για υπολογισμός και ταυτόχρονα γραφή σε τέτοια μορφή υπάρχουν εξειδικευμένα 

προγράμματα, όπως τα Mathcad, Mathematica, Maple, Maxima και πολλά άλλα. 

Στις παραστάσεις που δημιουργούμε μπορούμε να βάλουμε και πιο περίεργα σύμβολα. Για 

παράδειγμα: 

∫     
 

 

 
 

 
          

Τα σύμβολα   και   τα βρήκαμε στην παλέτα με τα ειδικά σύμβολα, στην καρτέλα 

Design, δίπλα στα υπόλοιπα εργαλεία δημιουργίας μαθηματικών παραστάσεων, χρησι-

μοποιώντας τα κουμπιά με τα βελάκια για να δούμε περισσότερα σύμβολα. Το σύμβολο   

ανήκει σε μια άλλη κατηγορία στην ίδια παλέτα. Για να δούμε τις διαθέσιμες κατηγορίες, 

πατάμε το βέλος που βρίσκεται στο κάτω μέρος και έπειτα πατάμε πάνω στον τίτλο Basic 

Math. Μπορούμε να βρούμε και άλλα χρήσιμα σύμβολα, όπως: 
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Παρατηρήστε πως, αφήνοντας για λίγο το ποντίκι πάνω από ένα σύμβολο, εμφανίζεται η 

εντολή με την οποία μπορούμε να το εισάγουμε από το πληκτρολόγιο. Για παράδειγμα: 

\forall    

Παρατηρήστε ότι χρειάζεται να πατήσουμε space αφού γράψουμε μια εντολή για να εκτε-

λεστεί και να εμφανιστεί το αντίστοιχο σύμβολο.  

Για την αρίθμηση των εξισώσεων δεν υπάρχει μέχρι στιγμής κάποιος ιδιαίτερα προφανής 

και εύχρηστος τρόπος. Εάν γνωρίζετε κάποιον, θα χαρούμε ιδιαιτέρως να τον περιγράψου-

με σε μια διορθωμένη έκδοση αυτού του φυλλαδίου. Βλέπε στο Παράρτημα μια όχι και τό-

σο δόκιμη μέθοδο για την αρίθμηση εξισώσεων. 

Εάν θέλετε να γράψετε μια εξίσωση μέσα στο κείμενο (π.χ.      ), απλώς την εισάγετε 

στο σημείο που θέλετε. Χρήσιμη συντόμευση είναι η Left Alt + = για τη δημιουργία μι-

ας μαθηματικής παράστασης στο σημείο που βρίσκεται ο κέρσορας. 

Εάν θέλουμε να χρησιμοποιήσουμε ένα σύμβολο μέσα στο κείμενό μας, μπορούμε: 

 είτε να δημιουργήσουμε μια μαθηματική παράσταση μόνο με αυτό 

 είτε να το εισάγουμε: καρτέλα Insert > Symbol > More Symbols… 

Εάν π.χ. εξηγούμε μέσα στο κείμενο την έννοια των συμβόλων που χρησιμοποιήσαμε σε 

μια μαθηματική παράσταση, θέλουμε τα σύμβολα που χρησιμοποιούμε στο κείμενο να εί-

ναι ακριβώς τα ίδια με τα σύμβολα που χρησιμοποιούμε στην παράσταση, άρα επιδιώκου-

με να χρησιμοποιούμε την ίδια γραμματοσειρά, οπότε προτιμάμε την πρώτη λύση. 

Παρατηρήστε τις διαφορές μεταξύ των παρακάτω: 

1 F=mΣ*a a=du/dt 

2 F=mΣ*a  

3                

4          
  

  
 

5          
  

  
 

6α  ⃗      ⃗  ⃗  
  ⃗⃗

  
 

6β          
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Στην περίπτωση (1), οι σχέσεις έχουν γραφτεί σαν απλό κείμενο, με τη γραμματοσειρά του 

κειμένου, με όλους τους χαρακτήρες «όρθιους» και χρησιμοποιώντας τον χαρακτήρα * για 

να δηλώσουμε τον πολλαπλασιασμό και το «Σ» που θέλει να υποδηλώσει «μάζα του σώμα-

τος» να μην είναι δείκτης. 

Στην περίπτωση (2), το «Σ» έχει μπει σε μορφή δείκτη, πατώντας το κουμπί Subscript 

που βρίσκεται στην καρτέλα Home. 

Στην περίπτωση (3) έχει χρησιμοποιηθεί απλώς το εργαλείο δημιουργίας εξισώσεων. Η 

γραμματοσειρά έχει αλλάξει και όλα τα γράμματα είναι πλάγια, ενώ το κλάσμα εμφανίζεται 

σε μορφή Linear (σε μια γραμμή). Σημειώστε πως συνηθίζεται να χρησιμοποιείται δια-

φορετική γραμματοσειρά για τις μαθηματικές παραστάσεις. Εκτός από λόγους αισθητικής 

και αναγνωσιμότητας, η γραμματοσειρά που χρησιμοποιείται για μαθηματικά θα πρέπει να 

περιέχει όλες τις απαραίτητες γλυφές, κάτι που είναι σπάνιο σε κοινές γραμματοσειρές α-

πλού κειμένου. 

Στην περίπτωση (4) έχει αντικατασταθεί το «λάθος» σύμβολο   με το σύμβολο   , και ταυτό-

χρονα, το κλάσμα έχει μετατραπεί σε μορφή Professional. 

Στην περίπτωση (5), άλλοι χαρακτήρες εμφανίζονται με πλάγιες και άλλοι με όρθιες γλυφές. 

Παρατηρήστε ότι αυτό συμβαίνει και σε πολλά βιβλία σας. Ένας απλός κανόνας, χωρίς να 

είναι όμως ακριβής είναι ο εξής: Τα σύμβολα που παίρνουν αριθμητική τιμή εμφανίζονται 

με πλάγιες γλυφές. Αντιθέτως, σύμβολα όπως οι τελεστές ή τα γράμματα που προσδιορί-

ζουν π.χ. κάποιο όνομα εμφανίζονται με όρθιες γλυφές. Έτσι, εδώ πλάγια εμφανίζονται τα: 

         , ενώ όρθια εμφανίζονται τα    . Επίσης, με όρθιες γλυφές εμφανίζονται οι μο-

νάδες μέτρησης και τα προθέματά τους (kilo, micro κτλ), κοινές συναρτήσεις όπως οι 

           , οι αριθμοί       και φυσικά τα στοιχεία του Περιοδικού Πίνακα. Οι φυσικές 

σταθερές συμβολίζονται με πλάγια γράμματα, π.χ. ο αριθμός Avogadro:   . Σε ορισμένα 

βιβλία χρησιμοποιείται μονάχα η «όρθια» μορφή των ελληνικών χαρακτήρων, ανεξαρτήτως 

του τι συμβολίζουν. Κανονικά ωστόσο εφαρμόζονται οι ίδιοι κανόνες (1). 

Στην περίπτωση (6), έχουν συμβολισθεί και τα διανύσματα. Στην περίπτωση 6α χρησιμο-

ποιούνται τα γνωστά βέλη, ενώ στην περίπτωση 6β ο συμβολισμός διανυσμάτων με πεζά 

bold και των βαθμωτών με απλά πεζά. Συνήθως οι πίνακες συμβολίζονται με κεφαλαία bold 

ή με δυο βέλη πάνω από το σύμβολό τους. Εδώ η δύναμη συμβολίζεται καταχρηστικά με 

κεφαλαίο. Εκτός από τα βέλη, συνηθίζεται και ο συμβολισμός με «περισπωμένες» κάτω 

από τα γράμματα. Πάντοτε με πλάγιες γλυφές. 

Επιδιώξτε να δημιουργείτε παραστάσεις σε μια από τις μορφές (5) ή (6). Όσο πιο κοντά 

στην κορυφή του πίνακα βρίσκεστε αυτή τη στιγμή, τόσο περισσότερο μπορείτε να βελτιω-

θείτε!  
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Μπορείτε να εντοπίσετε τις διαφορές στα παρακάτω παραδείγματα αντιδράσεων; 

1 Η2Ο + Η+ <----> Η3Ο+ 

2 Η2Ο + Η+ <----> Η3Ο
+ 

3      
     

  

4      
     

  

5      
     

  

6              

 

8 Εικόνες και γραφήματα 
Για να εισάγουμε μια εικόνα: καρτέλα Insert > Picture 

Επιλέγουμε την εικόνα που θέλουμε (πρέπει να την έχουμε στον υπολογιστή μας) και πα-

τάμε Insert. (η εικόνα προέρχεται από το openclipart.org υπό άδεια public domain) 

Οι εικόνες ανήκουν στην κατηγορία των “floating objects”, δηλαδή αντι-

κειμένων που μπορούν να τοποθετηθούν οπουδήποτε μέσα στο έγγρα-

φο. Για να μην μπλέκεται με το κείμενο, θα πρέπει να καθορίσουμε πώς 

θα συμπεριφέρεται η εικόνα απέναντι σε αυτό. Θα είναι στο φόντο; Σί-

γουρα δεν θέλουμε να καλύπτει το κείμενο. Θα υπάρχει κείμενο γύρω 

από την εικόνα; Θα είναι μόνη της σε έναν χώρο όπου δίπλα της δεν θα 

υπάρχει κείμενο; 

Πατώντας πάνω σε μια εικόνα, εμφανίζεται η καρτέλα Format. Για να ρυθμίσουμε τη σχέ-

ση εικόνας-κειμένου, παίζουμε με τις ρυθμίσεις στο Wrap Text. Συνηθισμένες επιλογές 

είναι οι Square και οι Top and Bottom. Με το Align μπορούμε να ρυθμίσουμε την 

οριζόντια ή την κατακόρυφη θέση της εικόνας. Παρέχονται επίσης διάφορα εργαλεία για 

στοιχειώδη επεξεργασία εικόνας (περιστροφή, φωτεινότητα κ.α.). Για να μικρύνουμε μια 

εικόνα, απλώς σέρνουμε μια από τις τέσσερις γωνίες της. Για να διατηρήσουμε τις αναλογί-

ες της, κρατάμε πατημένο το πλήκτρο shift καθώς αλλάζουμε το μέγεθος. 

Αν θέλουμε να εισάγουμε ένα διάγραμμα από το Microsoft Office Excel, αρκεί ένα απλό 

copy-paste, το οποίο θα δημιουργήσει ένα επεξεργάσιμο διάγραμμα. Πατώντας πάνω του 

εμφανίζονται τρεις σχετικές καρτέλες. Εξερευνήστε τις! 

Καλό είναι οι εικόνες και τα σχήματα να έχουν μια λεζάντα, στην οποία να φαίνεται ο αριθ-

μός τους και μια περιγραφή. Αυτό γίνεται ώστε να μπορούμε να αναφερόμαστε σε αυτά 

εύκολα αλλά και για να μπορεί όποιος βλέπει ένα σχήμα να καταλαβαίνει τι δείχνει, χωρίς 

να καταφύγει στο κείμενο. Αυτό γίνεται ως εξής: 

δεξί κλικ στο σχήμα > Insert Caption… 
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Σχήμα 1: Μεταβολή ρεύματος με το δυναμικό σε αναδιαλυτική βολταμετρία 

Επιλέγουμε το είδος (π.χ. εικόνα, πίνακας) από τα διαθέσιμα, ή δημιουργούμε ένα νέο εί-

δος (π.χ. σχήμα). Στη συνέχεια γράφουμε την περιγραφή του αντικειμένου και πατάμε OK. 

Εάν θέλουμε να αναφερθούμε σε ένα αντικείμενο που υπάρχει στο έγγραφό μας (πρακτικά 

αναφερόμαστε σε μια υπάρχουσα λεζάντα) εργαζόμαστε ως εξής: 

καρτέλα References > Cross-reference 

Επιλέγουμε σε τι (πχ εικόνα, σχήμα) θέλουμε να αναφερθούμε, αν θέλουμε να πάρουμε 

μόνο τον αριθμό του ή όλη τη λεζάντα του και πατάμε Insert. Έτσι, μπορούμε π.χ. να α-

ναφερθούμε στο Σχήμα 1. Πατώντας ctrl+κλικ πάνω στην αναφορά, μεταβαίνουμε στο 

αντίστοιχο αντικείμενο. Από την καρτέλα References μπορούμε ακόμα να φτιάξουμε 

έναν πίνακα σχημάτων. 

9 Πίνακες 
Για να δημιουργήσουμε έναν πίνακα: 

καρτέλα Insert > Table > επιλέγουμε διαστάσεις ή Insert Table… 

Παρατηρήστε πώς αλλάζει το βελάκι του ποντικιού αναλόγως τη θέση που το τοποθετούμε 

πάνω στον πίνακα. Αν περάσουμε το ποντίκι πάνω από το διαχωριστικό δυο στηλών ή δυο 

γραμμών του πίνακα, εμφανίζονται δυο αντίρροπα βέλη. Μπορούμε έτσι να μετακινήσουμε 

το διαχωριστικό. Κάνοντας διπλό κλικ, προσαρμόζεται στο ελάχιστο δυνατό πλάτος ή ύψος 

σύμφωνα με το περιεχόμενο. Αν πλησιάσουμε στο αριστερό περιθώριο ενός κελιού, το βε-

λάκι γίνεται παχύ και, πατώντας, επιλέγουμε όλο το κελί. Αν τοποθετήσουμε το ποντίκι στα 

αριστερά μιας γραμμής, γίνεται άσπρο και δείχνει προς τα δεξιά. Μπορούμε έτσι να επιλέ-

ξουμε μια ή περισσότερες ολόκληρες γραμμές. Αν πλησιάσουμε το ποντίκι στην πάνω αρι-

στερή γωνία του πίνακα εμφανίζεται ένα σύμβολο σαν σταυρός με βέλη. Με αυτό επιλέ-

γουμε ολόκληρο τον πίνακα. 

Τα κελιά του πίνακα μπορεί να περιέχουν οτιδήποτε. Από αριθμούς και κείμενο, μέχρι εικό-

νες, εξισώσεις και άλλους πίνακες. Επίσης, το περιεχόμενο σε κάθε κελί μπορεί να έχει τη 

δική του στοίχιση. Πατώντας πάνω στον πίνακα, εμφανίζονται δυο σχετικές καρτέλες. 
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Στην καρτέλα Design βρίσκονται εργαλεία που επιτρέπουν να μορφοποιήσουμε τον πίνακα 

με διάφορα έτοιμα στυλ ή να δημιουργήσουμε ένα δικό μας. Προτείνεται να αποφύγετε 

τους έντονα μορφοποιημένους πίνακες με τα πολλά χρώματα και τα παχιά περιγράμματα.  

Στην καρτέλα Layout βρίσκονται εργαλεία που επιτρέπουν την προσθήκη νέων γραμμών ή 

στηλών, καθώς και τη συγχώνευση (merge) ή το διαχωρισμό (split) κελιών. Μπορούμε να 

ισοκατανείμουμε διαθέσιμο χώρο σε κάποιες στήλες ή γραμμές, επιλέγοντάς τες και πατώ-

ντας Distribute Columns ή Distribute Rows αντιστοίχως. 

Συνηθέστερο είναι να εισάγουμε έναν έτοιμο πίνακα από Excel, όπου ισχύουν τα ίδια με τα 

γραφήματα: απλώς Copy-Paste. Αφού κάνουμε την επικόλληση, εμφανίζεται στην κάτω δε-

ξιά γωνία ένα εικονίδιο με διάφορες επιλογές επικόλλησης με τις οποίες μπορούμε να πει-

ραματιστούμε. Μπορούμε να συνδέσουμε τον πίνακα με το αντίστοιχο αρχείο Excel, ώστε 

οι αλλαγές που γίνονται σε αυτό να μεταφέρονται στον πίνακα που έχουμε στο Word. Ω-

στόσο κάτι τέτοιο απαιτεί ιδιαίτερη προσοχή και δεν προτείνεται. 

t (min) pH 

0 4.944 

1 5.489 

2 5.724 

3 5.902 

4 6.056 

5 6.187 
Πίνακας 1: Μεταβολή pH στον αντιδραστήρα 

Από πλευράς μορφοποιήσεων, οι συνηθέστερες είναι η αλλαγή στα περιγράμματα και στο 

γέμισμα κελιών. Αυτό μπορεί να γίνει επιλέγοντας τα κελιά που μας ενδιαφέρουν και κάνο-

ντας έπειτα δεξί κλικ > Borders and Shading…. Επιλέγουμε το επιθυμητό εί-

δος, πάχος και χρώμα γραμμής και κάνουμε κλικ στο περιθώριο που θέλουμε να αλλάξου-

με. Εάν το περίγραμμα σε κάποιο σημείο είναι γκρι, σημαίνει ότι σε κάποιες περιοχές είναι 

διαφορετικό ή δεν υπάρχει. Πατώντας πάνω του μπορούμε να το εμφανίσουμε ή να το α-

ποκρύψουμε. 

10 Αναφορές σε αντικείμενα και σημεία του κειμένου 
Για να αναφερθούμε σε ένα αντικείμενο (εικόνα, σχήμα, πίνακα, εξίσωση), πρέπει να έχει 

λεζάντα. Η διαδικασία έχει ήδη αναφερθεί ήδη στη σελίδα 16, σχετικά με τις εικόνες: 

Εάν θέλουμε να αναφερθούμε σε ένα αντικείμενο που υπάρχει στο έγγραφό μας (πρα-

κτικά αναφερόμαστε σε μια υπάρχουσα λεζάντα) εργαζόμαστε ως εξής:   

καρτέλα References > Cross-reference 

Επιλέγουμε σε τι (πχ εικόνα, σχήμα) θέλουμε να αναφερθούμε, αν θέλουμε να πάρουμε 

μόνο τον αριθμό του ή όλη τη λεζάντα του και πατάμε Insert. Έτσι, μπορούμε π.χ. να 

αναφερθούμε στο Σχήμα 1. Πατώντας ctrl+κλικ πάνω στην αναφορά, μεταβαίνουμε 

στο αντίστοιχο αντικείμενο. Από την καρτέλα References μπορούμε ακόμα να φτιά-

ξουμε έναν πίνακα σχημάτων. 
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Για να αναφερθούμε σε ένα σημείο του κειμένου (π.χ. στη «σελίδα 16»), πρέπει πρώτα να 

βάλουμε έναν «σελιδοδείκτη» στο σημείο που θέλουμε να αναφερθούμε. Έτσι: 

καρτέλα Insert > Bookmark 

Γράφουμε ένα όνομα (χωρίς κενά) και πατάμε Add. Στη συνέχεια, για να αναφερθούμε σε 

αυτό το σημείο: 

καρτέλα References > Cross-reference > Reference type: Book-

mark > Insert reference to: Page number 

Με αυτόν τον τρόπο παίρνουμε αυτόματα μονάχα τον αριθμό της σελίδας στον οποίο βρί-

σκεται το bookmark. Σημειώστε ότι έχουμε σημαδέψει μόνο ένα σημείο και όχι μια περιο-

χή. Το κείμενο που παρατέθηκε, απλώς αντιγράφηκε και επικολλήθηκε, εφαρμόζοντας πα-

ράλληλα το στυλ Quote, το οποίο το έχουμε τροποποιήσει, εμφανίζοντας ένα παχύ αρι-

στερό περίγραμμα. 

11 Αναφορές στη βιβλιογραφία 
Το Word έχει το δικό του σύστημα διαχείρισης βιβλιογραφίας. Για να αναφερθούμε σε κά-

ποια πηγή, πρέπει πρώτα να προσθέσουμε τα στοιχεία της στη βάση δεδομένων του Word: 

καρτέλα References > Manage Sources > New… 

Επιλέγουμε το είδος της πηγής στην οποία θα αναφερθούμε (βιβλίο, άρθρο, …), εισάγουμε 

όσα στοιχεία γνωρίζουμε για αυτήν στα αντίστοιχα κελιά και πατάμε OK. 

Για παράδειγμα, έστω ότι θέλουμε να αναφερθούμε στις σελίδες 27-29 του βιβλίου: 

Levenspiel, O.: “Chemical Reaction Engineering”, 3rd ed., Wiley, 1999 

 

Επιλέγουμε Type of source: Book. Για τον συγγραφέα, πατάμε Edit δίπλα στο Author 

και συμπληρώνουμε στα πεδία Last και First το επώνυμο και το μικρό όνομα του συγ-

γραφέα. Στη συνέχεια, πληκτρολογούμε τον τίτλο στο Title, τον χρόνο έκδοσης στο Year 

και τον εκδότη στο Publisher.  

Για να συμπληρώσουμε τον αριθμό έκδοσης και τις σελίδες, εμφανίζουμε όλα τα βιβλιο-

γραφικά πεδία, «τικάροντας» πρώτα το Show all Bibliographic Fields. Τώρα 

μπορούμε να συμπληρώσουμε τα πεδία Edition και Pages. Επιστρέφοντας στο κεντρικό 

παράθυρο της διαχείρισης πηγών, επιλέγουμε την πηγή που θέλουμε να χρησιμοποιήσου-

με και κάνουμε Copy->Current List. 

Πλέον, μπορούμε να αναφερθούμε στο βιβλίο (2). Πρέπει ωστόσο να εμφανίσουμε και στο 

κείμενο τη βιβλιογραφία που χρησιμοποιήσαμε: 

καρτέλα References > Bibliography > επιθυμητό στυλ 

Θα προκύψει το εξής, κάτω από τον τίτλο της Βιβλιογραφίας: 
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2. Levenspiel, Octave. Chemical Reaction Engineering. 3rd. s.l. : Wiley, 1999. σσ. 27-29. 

Αυτό που θα παραχθεί σε εσάς ενδέχεται να διαφέρει, καθώς υπάρχουν διάφορα στυλ βι-

βλιογραφίας. Αυτό καθορίζεται από το Style στην ίδια καρτέλα. Με μια αναζήτηση στο 

διαδίκτυο μπορείτε να βρείτε αρκετές πληροφορίες για το πώς να εισάγετε νέα στυλ βιβλι-

ογραφίας και πώς να δημιουργήσετε το δικό σας. Το θέμα ωστόσο δεν είναι τόσο απλό και 

ξεφεύγει από το εισαγωγικό πεδίο αυτού του φυλλαδίου. Σε αυτό το φυλλάδιο χρησιμο-

ποιείται το στυλ ISO 690 – Numerical Reference, χωρίς απαραίτητα να προτείνε-

ται για χρήση σε εργασίες. 

12 Ορθογραφικός έλεγχος 
To Word παρέχει μια λειτουργία ορθογραφικού και γραμματικού ελέγχου. Αυτή είναι ενερ-

γοποιημένη από την αρχή και, γράφοντας μια λέξη λάθος, θα υπογραμμιστεί με μια κόκκινη 

τεθλασμένη γραμμή. Κάνοντας δεξί κλικ σε αυτήν, μπορούμε να δούμε προτεινόμενες λέ-

ξεις που μοιάζουν με αυτή που έχουμε γράψει. 

Ο ορθογραφικός έλεγχος βασίζεται σε ένα λεξικό έτοιμων λέξεων και, φυσικά, εκτελείται 

από μηχανή. Συνεπώς, ενδέχεται λέξεις που έχουμε γράψει σωστά να μην αναγνωρίζονται 

ως σωστές (αλλά και λάθη μας να μην ανιχνεύονται). Στην περίπτωση αυτή μπορούμε να 

επιλέξουμε να αγνοήσουμε (Ignore) αυτό το «λάθος», ή να προσθέσουμε τη λέξη στο 

λεξικό του Word (Add to Dictionary). Προτού το κάνουμε αυτό, καλό θα ήταν να 

συμβουλευτούμε ένα κανονικό λεξικό! 

Για να αναθεωρήσουμε το κείμενό μας ως προς τα ορθογραφικά λάθη που περιέχει: 

καρτέλα Review > Spelling & Grammar 

Επιλέγουμε γλώσσα για τον ορθογραφικό έλεγχο και διορθώνουμε ένα-ένα τα λάθη που 

εμφανίζονται. Για κάθε γλώσσα γραφής χρησιμοποιείται διαφορετικό λεξικό. Έτσι, αν έχου-

με επιλέξει ελληνικό λεξικό, οι αγγλικές λέξεις θα θεωρούνται λανθασμένες και αντιστρό-

φως. 

Στην αγγλική έκδοση του Word δεν παρέχεται απ’ ευθείας ελληνικό λεξικό. Μπορούμε να 

προσθέσουμε ελληνικό λεξικό εγκαθιστώντας το Greek Language Pack για την έκδοση του 

Microsoft Office που χρησιμοποιούμε, ακολουθώντας τις οδηγίες που το συνοδεύουν. Αυτό 

μπορεί να μας παρέχει (προαιρετικά) και αρχεία βοήθειας στα ελληνικά, καθώς και ολό-

κληρο το περιβάλλον χρήσης μεταφρασμένο στα ελληνικά. 
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13 Αποθήκευση και εξαγωγή σε PDF 
Για να μην χάσουμε το έγγραφο που με τόσο κόπο δημιουργήσαμε, πρέπει να το αποθη-

κεύσουμε στον υπολογιστή μας. Αρχικά ακολουθούμε την εξής διαδικασία: 

μενού File > Save As > επιθυμητό όνομα και τοποθεσία > Save 

Το όνομα του αρχείου θα ήταν καλό να περιέχει μονάχα αγγλικούς χαρακτήρες, χωρίς να 

υπάρχει πρόβλημα με τους ελληνικούς, παρά μονάχα σε ειδικές περιπτώσεις ανταλλαγής 

αρχείων με παλιά λειτουργικά συστήματα (βλ. “encoding”). 

Μπορούμε να επιλέξουμε τον τύπο του αρχείου που θα χρησιμοποιηθεί, ο οποίος υποδει-

κνύεται γενικώς από την κατάληξη του ονόματος ενός αρχείου. Και εδώ ξεκινά μια πικρή 

ιστορία. Οι επικρατέστερες επιλογές σας για αποθήκευση σε επεξεργάσιμη μορφή είναι: 

Πρότυπο Κατάληξη Περιγραφή (Word 2010) 

Microsoft Office Open XML .docx Word Document 

Microsoft Word Binary Format .doc Word 97-2003 Document 

Open Document Format (text) .odt OpenDocument Text 

Το docx είναι ο προεπιλεγμένος τύπος αρχείων, ο οποίος υποστηρίζει πλήρως όλες τις λει-

τουργίες της έκδοσης του Word που χρησιμοποιείτε. Ωστόσο, δεν υποστηρίζεται από πα-

λαιότερες εκδόσεις του Word (2003 και προηγούμενες). 

Το doc ήταν ο προεπιλεγμένος τύπος αρχείων παλαιότερα. Αν αποθηκεύσετε σε αυτόν τον 

τύπο, το έγγραφό σας θα είναι επεξεργάσιμο και από παλιότερες εκδόσεις, ωστόσο θα χά-

σετε κάποιες πληροφορίες. Για παράδειγμα, οι εξισώσεις θα μετατραπούν σε εικόνες και 

δεν θα είναι επεξεργάσιμες, ενώ η ευκρίνειά τους θα είναι μειωμένη. 

Σημειώστε ότι από τη Microsoft παρέχονται δωρεάν προγράμματα που επιτρέπουν την α-

νάγνωση (όχι όμως την επεξεργασία) των νεότερων αρχείων σε υπολογιστές που διαθέτουν 

παλιότερες ή καμία έκδοση του Word. Ψάξτε για “Microsoft Word Viewer”. Δείτε επίσης το 

“Microsoft Office Compatibility Pack for Word, Excel and PowerPoint File Formats”. 

Το βασικό πρόβλημα των doc, docx είναι ότι υποστηρίζονται πλήρως μονάχα από το Mi-

crosoft Office, το οποίο υπάρχει μόνο για Microsoft Windows και Apple MacOS X. Και υπάρ-

χουν λόγοι που δυσκολεύουν την πλήρη υποστήριξή τους από άλλα προγράμματα. 

Το odt είναι ένα σχετικά νέο ανοιχτό πρότυπο, το οποίο αναπτύσσεται από το Open Doc-

ument Foundation, με σκοπό να αποτελέσει ένα ανοιχτό είδος αρχείων που να υποστηρίζε-

ται από κάθε σουίτα εφαρμογών γραφείου, σε κάθε λειτουργικό. Όπως στο doc, δεν υπο-

στηρίζονται όλες οι λειτουργίες του Word, είναι ωστόσο ο βασικός τύπος αρχείων που χρη-

σιμοποιεί το LibreOffice και άλλα. Γύρω από το θέμα μπορείτε να βρείτε αρκετές συζητή-

σεις στο διαδίκτυο.  

Εάν θέλετε να στείλετε το κείμενό σας σε κάποιον μονάχα για να το διαβάσει, τότε προτιμή-

στε να το εξάγετε σε μορφή PDF (Portable Document Format). Το προτιμάτε και εσείς και ο 

παραλήπτης. Εσείς, καθώς δεν θα μπορεί να αλλάξει το έγγραφό σας και είστε σχεδόν σί-

γουρος ότι θα βλέπετε το έγγραφο με την ίδια ακριβώς μορφή. Αυτός, καθώς δεν χρειάζε-
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ται να έχει εγκατεστημένη την απαιτούμενη έκδοση του Word και μπορεί να διαβάσει εύ-

κολα ένα αρχείο pdf, ενώ μπορεί να το διαβάσει άνετα σε οποιαδήποτε συσκευή και λει-

τουργικό σύστημα, ακόμα και σε κινητά τηλέφωνα! Επίσης, το μέγεθος του αρχείου θα εί-

ναι σημαντικά μικρότερο. 

Αρχεία pdf μπορείτε επίσης να δημιουργήσετε με κάποιο ξεχωριστό πρόγραμμα, το οποίο 

είναι πρακτικά ένας «pdf εκτυπωτής». Με τέτοια προγράμματα μπορείτε επίσης να ενώ-

σετε πολλά αρχεία σε ένα pdf, παράγοντας έτσι ένα αρχείο όμοιο με το τυπωμένο αντίτυπο 

που θα δίνατε σε κάποιον. Ένα τέτοιο πρόγραμμα είναι το ελεύθερο PDF Creator. 

14 Εκτύπωση 
Προτού εκτυπώσετε το έγγραφό σας, καλό είναι να δείτε μια προεπισκόπησή του: 

μενού File > Print 

Χρήσιμο θα ήταν, εάν ο εκτυπωτής σας το υποστηρίζει, να ζητήσετε εκτύπωση διπλής όψης, 

από αυτό το μενού. Επίσης, από τις ρυθμίσεις του εκτυπωτή σας, μπορείτε να τυπώσετε 

ένα πρόχειρο (draft), ξοδεύοντας λιγότερο μελάνι και χρόνο. Όταν είστε έτοιμοι, Print!
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Παράρτημα Ι: Ελληνικοί όροι 
Στην ελληνική έκδοση του Word 2010, οι μεταφράσεις των όρων που εμφανίζονται είναι: 

Αγγλικοί όροι Ελληνικοί όροι 

Add to Dictionary Προσθήκη στο λεξικό 

Bookmark Σελιδοδείκτης 

Borders and Shading Περιγράμματα και σκίαση 

Breaks Αλλαγές 

Current list Τρέχουσα λίστα 

Design (tab) (hidden) Σχεδίαση (καρτέλα) (κρυφή) 

Distribute Columns / Distribute Rows Κατανομή στηλών / Κατανομή γραμμών 

Equation Εξίσωση 

File Αρχείο 

Format painter Πινέλο μορφοποίησης 

Heading / Title / Subtitle/ Emphasis Επικεφαλίδα / Τίτλος / Υπότιτλος / Έμφαση 

Home (tab) Κεντρική (καρτέλα) 

Hyphenation Συλλαβισμός 

Ignore Παράβλεψη 

Insert (tab) Εισαγωγή (καρτέλα) 

Insert Caption Εισαγωγή λεζάντας 

Layout (tab) (hidden) Διάταξη (καρτέλα) (κρυφή) 

Line and Paragraph Spacing Διάστιχο και απόσταση παραγράφων 

Mailings (tab) Στοιχεία αλληλογραφίας (καρτέλα) 

Manage Sources Διαχείριση προελεύσεων 

Modify Τροποποίηση 

Multilevel List Λίστα πολλών επιπέδων 

Navigation Pane Παράθυρο περιήγησης 

Normal Βασικό 

Outline Διάρθρωση 

Page layout (tab) Διάταξη σελίδας (καρτέλα) 

Picture Εικόνα 

Print Εκτύπωση 

Quote Απόσπασμα 

References (tab) Αναφορές (καρτέλα) 

Review (tab) Αναθεώρηση (καρτέλα) 

Save as Αποθήκευση ως 

Section breaks Αλλαγές ενοτήτων 

Square Τετράγωνη 

Styles Στυλ 

Subscript Δείκτης 

Superscript Εκθέτης 

Table of Contents Πίνακας περιεχομένων 

Theme Θέμα 

Top and Bottom Επάνω και κάτω 

Update table Ενημέρωση πίνακα 

View (tab) Προβολή (καρτέλα) 

Wrap text Αναδίπλωση κειμένου 
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Παράρτημα ΙΙ: Αρίθμηση εξισώσεων the hard way 
Η αρίθμηση εξισώσεων δεν είναι τόσο απλή υπόθεση στο Word όσο π.χ. στο LaTeX. Μπο-

ρούμε ωστόσο να παράξουμε με μια εκτενέστερη διαδικασία ένα αποτέλεσμα κοντά στο 

επιθυμητό, ως εξής: 

1. Δημιουργούμε έναν πίνακα 1x2 (μια γραμμή, δυο στήλες): 

  

 

2. Μετακινούμε το διαχωριστικό, μικραίνοντας το δεξί κελί: 

  

 

3. Εισάγουμε την εξίσωση στο αριστερό κελί, στοιχίζοντάς την κατά βούληση. Το ύψος του 

πίνακα αλλάζει αυτόματα, ώστε να χωράει ολόκληρη την εξίσωση: 

∫     
 

 

 
 

 
          

 

 

4. Επιλέγουμε όλον τον πίνακα και κάνουμε δεξί κλικ > Insert Caption. Ως 

Label επιλέγουμε «Εξίσωση» και επιλέγουμε Exclude label from caption: 

∫     
 

 

 
 

 
          

 

1 

5. Κάνουμε cut-paste τη λεζάντα στο δεξί κελί. Προσθέτουμε παρενθέσεις, μορφοποιούμε 

κατά βούληση και στοιχίζουμε στο κέντρο από την καρτέλα Layout: 

∫     
 

 

 
 

 
          (1) 

 

6. Αφαιρούμε τα περιγράμματα από τον πίνακα: 

∫     
 

 

 
 

 
          (1) 

 

Έτσι, μπορούμε τώρα να αναφερθούμε π.χ. στην εξίσωση (1). Ο τρόπος αυτός δεν θεωρεί-

ται ικανοποιητικός, ωστόσο είναι μια λύση για «αυτόματη» αρίθμηση εξισώσεων. Αν υπάρ-

χει κάποιος καλύτερος τρόπος θα χαρούμε να μας τον επισημάνετε!  

Σημειώστε ότι στο LaTeX, κάθε εξίσωση αποκτά αυτομάτως έναν αριθμό δίπλα της, με την 

κατάλληλη μορφοποίηση, χωρίς καμία ειδική μεταχείριση.  
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Παράρτημα ΙΙI: Συντομεύσεις πληκτρολογίου 
 

Λειτουργία Συνδυασμός πλήκτρων 

Copy (αντιγραφή) Ctrl + C 

Cut (αποκοπή) Ctrl + X 

Paste (επικόλληση) Ctrl + V 

Select All (επιλογή όλων) Ctrl + A 

Undo (αναίρεση) Ctrl + Z 

Redo (επανάληψη) Ctrl + Y 

Save (αποθήκευση) Ctrl + S 

Find (εύρεση) Ctrl + F 

Replace (αντικατάσταση) Ctrl + H 

Format: Bold (έντονα) Ctrl + B 

Format: Italic (πλάγια) Ctrl + I 

Format: Underline (υπογραμμισμένα) Ctrl + U 

Format: Subscript (δείκτης) Ctrl + = 

Format: Superscript (εκθέτης) Ctrl + Shift + = 

Align: Left (στοίχιση αριστερά) Ctrl + L 

Align: Right (στοίχιση δεξιά) Ctrl + R 

Align: Center (στοίχιση στο κέντρο) Ctrl + E 

Align: Justify (πλήρης στοίχιση) Ctrl + J 

Symbol: € Ctrl + Alt + Ε (πληκτρολόγιο στα ελληνικά) 

Symbol: ° Ctrl + Alt + 0 (πληκτρολόγιο στα ελληνικά) 

Symbol: ± Ctrl + Alt + - (πληκτρολόγιο στα ελληνικά) 

Symbol: ΐ (διαλυτικά με τόνο) Shift + ς 

Αλλαγή γραμμής χωρίς αλλαγή παραγράφου Shift + Enter 

Page Break (αλλαγή σελίδας) Ctrl + Enter 

Insert Equation (εισαγωγή εξίσωσης) Left Alt + = 

 

Περνώντας το ποντίκι πάνω από κάποιο κουμπί, εμφανίζεται μια περιγραφή της λειτουργί-

ας του και η αντίστοιχη συντόμευση πληκτρολογίου (αν υπάρχει). Πατώντας μια φορά το 

πλήκτρο Alt εμφανίζονται οι συντομεύσεις για κάθε καρτέλα. 
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Παράρτημα ΙV: Εντολές του εργαλείου μαθηματικών 
Γράφοντας μια από τις παρακάτω εντολές κατά τη δημιουργία μιας εξίσωσης και πατώντας 

το πλήκτρο space, εμφανίζεται το αντίστοιχο σύμβολο/μορφή. 

Εντολή Αποτέλεσμα 

a^b    
a_b    
a \cdot b     
\sqrt(x) √  
a\vec (δυο φορές το space)  ⃗ 
a\dot (δυο φορές το space)  ̇ 
a\tilde (δυο φορές το space)  ̃ 
10 \pm 0.5        
25 \degc     
a >= b     
a <= b     
A \Rightarrow B     
A \Leftrightarrow B      

\int _0^1 x dx ∫     
 

 

 

[ \matrix(1&2@3&4) ] (δυο φορές το space) [ 
  
  
]   

 

Περνώντας το ποντίκι πάνω από το σύμβολο που μας ενδιαφέρει, μπορούμε να δούμε την 

εντολή που το δημιουργεί, αν υπάρχει. Φυσικά, εδώ παρουσιάστηκαν μονάχα οι συνηθέ-

στερα χρησιμοποιούμενες. 

Όλες οι διαθέσιμες εντολές βρίσκονται στο: 

μενού File > Options > Proofing > AutoCorrect Options > Math 

AutoCorrect 

Από εκεί, μπορούμε ακόμα να προσθέσουμε και τις δικές μας συντομεύσεις. Π.χ., για να 

αντιστοιχίσουμε το σύμβολο της συνεπαγωγής στο «=>»: 

1. Στο “Replace:” γράφουμε «=>» 

2. Κάνουμε copy-paste από μια εξίσωση το σύμβολο « » στο “With:” 
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